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นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ก เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

ค าน า 

 

หนังสืออิเล็กทรอนิกส์ (E-book) เป็นความก้าวหน้าของเทคโนโลยีที่พัฒนาเอกสารให้อยู่ใน
รูปแบบสื่ออิเล็กทรอนิกส์ เป็นการให้ความรู้แก่ผู้สนใจอีกทางเลือกหนึ่ง ส่งเสริมให้เข้าถึงการเรียนรู้
อย่างสะดวก รวดเร็ว ตามความต้องการและศักยภาพของแต่ละบุคคล ช่วยกระตุ้นให้เกิดความใฝ่รู้  
ใฝ่เรียน สนุกสนาน จากภาพ เสียง ภาพเคลื่อนไหว สิ่งหนึ่งที่ส าคัญคือ หนังสืออิเล็กทรอนิกส์สามารถ
ปรับปรุงข้อมูลให้ทันสมัยได้ตลอดเวลา ซึ่งคุณสมบัติเหล่านี้จะไม่มีในหนังสือธรรมดาทั่วไป 

 เอกสารประกอบการเรียน เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ (E-book) ด้วยโปรแกรม 
Desktop Author ส าหรับนักเรียนชั้นมัธยมศึกษาชั้นปีที่ 1 กลุ่มสาระการเรียนรู้การงานอาชีพและ
เทคโนโลยีนี้ มีวัตถุประสงค์ในการจัดท าเพื่อเป็นสื่อประกอบการเรียนการสอนให้นักเรียนได้ศึกษา
ค้นคว้า และเรียนรู้ด้วยตนเอง ก่อให้เกิด ความรู้ ทักษะ ในการสร้างหนังสืออิเลกทรอนิกส์ (E-book) 
ขึ้นมาเพื่อใช้งานและเผยแพร่อย่างถูกต้อง ตลอดจนมีคุณลักษณะอันพึงประสงค์เหมาะสมกับวัย
ผู้เรียน โดยจัดท าจ านวน 5 เล่ม ประกอบด้วย 

 เล่มที่ 1 หนังสืออิเลกทรอนิกส์และโปรแกรม Desktop Author 
 เล่มที่ 2 การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ 
 เล่มที่ 3 ข้อความและ Multimedia 
 เล่มที่ 4 การแทรกปุ่มปฏิบัติการ (Buttons) และการเชื่อมโยง (Link) 
 เล่มที่ 5 การสร้างแบบทดสอบและการเผยแพร่ผลงาน 

ท้ายนี้ผู้จัดท าหวังเป็นอย่างยิ่งว่าเอกสารประกอบการเรียนเล่มนี้ จะเกิดประโยชน์กับผู้ศึกษา
อย่างสูงสุด หากมีข้อเสนอแนะใดที่จะท าให้เอกสารประกอบการเรียนเล่มนี้สมบูรณ์ยิ่งขึ้น ผู้จัดท าน้อม
รับฟังข้อเสนอแนะและขอขอบคุณ ณ โอกาสนี้ 

 

นายสามารถ กล่อมเกลา 

www.kr
oo

ba
nn

ok
.co

m



 

 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ข เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

สารบัญ 

 หน้า 
ค าน า ก 
สารบัญ ข 
สารบัญภาพ ค 
ค าช้ีแจงส าหรับคร ู ง 
ค าช้ีแจงส าหรับนักเรียน จ 
สาระส าคัญ จุดประสงค์การเรียนรู ้ 1 
แบบทดสอบก่อนเรียน 2 
ใบความรู้ที่ 1 เรื่อง การก าหนดรูปแบบของหนังสืออิเลกทรอนิกส์ 4 
แบบฝึกหัดที่ 1 การก าหนดค่าพ้ืนฐานของหนังสืออิเลกทรอนิกส์ 7 
ใบความรู้ที่ 2 เรื่อง การแบ่งหน้ากระดาษ 8 
ใบความรู้ที่ 3 เรื่อง การบันทึกงาน 11 
ใบงานที่ 1 เรื่อง การก าหนดรูปแบบหนังสืออิเล็กทรอนิกส์ 12 
ใบความรู้ที่ 4 เรื่อง การสร้างปกหน้าหนังสืออิเล็กทรอนิกส์ 13 
ใบงานที่ 2 เรื่อง การท าปกหน้าและปกหลังหนังสืออิเล็กทรอนิกส์ (E-Book) 18 
ใบความรู้ที่ 5 เรื่อง การจัดการหน้าหนังสืออิเล็กทรอนิกส์ 19 
ใบความรู้ที่ 6 เรื่อง การสร้างปกหลังหนังสืออิเล็กทรอนิกส์ 23 
ใบความรู้ที่ 7 เรื่อง การสร้างหนังสือด้วย Template 27 
ใบงานที่ 3 เรื่อง การจัดการหน้าหนังสือและการใช้ Template สร้างหนังสืออิเล็กทรอนิกส์ 34 
แบบทดสอบหลังเรียน 35 
ภาคผนวก 37 
     กระดาษค าตอบ 38 
     เฉลยแบบทดสอบ 39 
     เฉลยแบบฝึกหัดที่ 1 40 
     หนังสืออ้างอิง 41 
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ค เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

สารบัญภาพ 

 หน้า 
ภาพที่ 2.1 การเปิดโปรแกรมด้วย File แล้วคลิกเลือก New 4 
ภาพที่ 2.2 การเปิดโปรแกรมด้วยการคลิก Icon New 4 
ภาพที่ 2.3 หน้าต่าง eBook Properties 5 
ภาพที่ 2.4 หน้าต่างแสดงหน้ากระดาษหลังจากที่ได้ก าหนด eBook Properties 8 
ภาพที่ 2.5 การก าหนดจุดแบ่งครึ่งหน้ากระดาษ 8 
ภาพที่ 2.6 การเลือกค าสั่งเพ่ือเลือกแบบเส้นการแบ่งหน้าหนังสือ 9 
ภาพที่ 2.7 แสดงการเลือกรูปแบบของเส้นแบ่งหน้าหนังสือ 9 
ภาพที่ 2.8 แสดงการย้ายเส้นแบ่งหน้าต าแหน่งหนังสือ 10 
ภาพที่ 2.9 แสดงการบันทึกหนังสือที่แทรกเส้นแบ่งหน้าแล้ว 11 
ภาพที่ 2.10 แสดงการเลือกใช้ค าสั่ง Tools > Book Transparency 13 
ภาพที่ 2.11 แสดงการก าหนดค่าในหน้าต่าง Book Transparency Setting 13 
ภาพที่ 2.12 แสดงการสร้างกล่องส าหรับปิดหน้าที่ไม่ต้องการให้แสดงผล 14 
ภาพที่ 2.13 แสดงการเลือกสีของกล่อง 14 
ภาพที่ 2.14 แสดงกล่องที่จะใช้ส าหรับปิดหน้ากระดาษด้านซ้าย 15 
ภาพที่ 2.15 แสดงการขยายกล่องเพ่ือปิดส่วนที่ไม่ต้องการให้แสดงผล 15 
ภาพที่ 2.16 แสดงการใช้ค าสั่ง Insert Box 16 
ภาพที่ 2.17 แสดงภาพที่เลือกจากค าสั่ง Insert Image 16 
ภาพที่ 2.18 แสดงการจัดต าแหน่งภาพลงในปกหน้าหนังสือ 17 
ภาพที่ 2.19 แสดงการเลือกค าสั่ง DNL Package 17 
ภาพที่ 2.20 แสดงการประมวลผล Package 17 
ภาพที่ 2.21 แสดงหน้าปกหนังสือที่สร้าง 18 
ภาพที ่2.22 แสดงขั้นตอนการออกจากหน้าแสดงผล DNL Package 18 
ภาพที ่2.23 แสดงการเลือกค าสั่งเพิ่มหน้ากระดาษ 20 
ภาพที ่2.24 แสดงจ านวนหน้าหนังสือที่ท างานอยู่จากที่มทีั้งหมด 20 
ภาพที ่2.25 แสดงการเลอืกค าสั่งลบหน้ากระดาษ 21 
ภาพที ่2.26 แสดงการเลือกค าสั่งย้ายหน้ากระดาษ 21 
ภาพที ่2.27 แสดงการเลือกค าสั่งคัดลอกหน้ากระดาษ 22 
ภาพที ่2.28 แสดงค าสั่งในการเรียกดูหน้ากระดาษ 22 
ภาพที ่2.29 แสดงการเลือกค าสั่งการเพิ่ม/การลบหน้ากระดาษครั้งละหลายหน้า 23 
ภาพที ่2.30 แสดงการเลือกค่าการเพิ่ม/การลบหน้ากระดาษ 23 
ภาพที ่2.31 แสดงการก าหนดค่าในหน้าต่าง Book Transparency Setting 24 
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ง เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

สารบัญภาพ 

 หน้า 
ภาพที ่2.32 แสดงการสร้างกล่องส าหรับปิดหน้าที่ไม่ต้องการให้แสดงผล 25 
ภาพที ่2.33 แสดงการเลือกสีของกล่อง 25 
ภาพที ่2.34 แสดงกล่องที่จะใช้ส าหรับปิดหน้ากระดาษด้านขวา 26 
ภาพที ่2.35 แสดงการขยายกล่องเพ่ือปิดส่วนที่ไม่ต้องการให้แสดงผล 26 
ภาพที ่2.36 แสดงการทดลองแทรกภาพลงในปกหลัง 27 
ภาพที ่2.37 แสดงการจัดต าแหน่งภาพในปกหลัง 27 
ภาพที ่2.38 แสดงการเลือก Template 28 
ภาพที ่2.39 ตัวอย่าง Template Front_Cover 28 
ภาพที ่2.40 ตัวอย่าง Template Double_Page 29 
ภาพที ่2.41 ตัวอย่าง Template Double_Page2 29 
ภาพที ่2.42 ตัวอย่าง Template Back_Cover 29 
ภาพที ่2.43 แสดงการสร้างหนังสือใหม่ 30 
ภาพที ่2.44 แสดงการเลือก Front_Cover 31 
ภาพที ่2.45 แสดงหน้าปกที่ได้จาก Template 31 
ภาพที ่2.46 แสดงการเลือก Double_Page 32 
ภาพที ่2.47 แสดงหน้าเนื้อหาที่ได้จาก Template 32 
ภาพที ่2.48 แสดงการเลือก Back_Cover 33 
ภาพที ่2.49 แสดงปกหลังที่ได้จาก Template 34 
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จ เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

ค าชี้แจงส าหรับคร ู

 

เอกสารประกอบการเรียน เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ (E-book) ด้วยโปรแกรม 
Desktop Author เล่มที่ 2 เรื่อง “การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ” เล่มนี้ใช้
ประกอบการจัดกิจกรรมการเรียนการสอนนักเรียนชั้นมัธยมศึกษาปีที่ 1 โรงเรียนท่าตะโกพิทยาคม 
ส านักงานเขตพ้ืนที่การศึกษามัธยมศึกษา เขต 42 มีขั้นตอนในการจัดกิจกรรมการเรียนการสอนดังนี้ 

 1.  ครูแจกเอกสารประกอบการเรียน เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ (E-book) ด้วย
โปรแกรม Desktop Author เล่มที่ 2 เรื่อง “การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ”  ให้แก่
นักเรียน 
 2.  ครูช้ีแจงการใช้เอกสารประกอบการเรียนใหน้ักเรียนทราบก่อนลงมือปฏิบัติ 
 3.  ครูให้นักเรียนท าแบบทดสอบก่อนเรียน เพื่อดูความรู้พื้นฐานของนักเรียน 
 4.  ครูให้นักเรียนศึกษาเอกสารประกอบการเรียน เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์    
(E-book) ด้วยโปรแกรม Desktop Author เล่มที่ 2 เรื่อง “การก าหนดค่าพื้นฐานและการสร้างปก
หนังสือ”  ปฏิบัติตามใบความรู้ ใบงาน และแบบฝึกหัด 
 5.  ครูให้นักเรียนท าแบบทดสอบหลังเรียน เพื่อดูว่านักเรียนมีความรู้ ความเข้าใจมากขึ้น
เพียงใด 
 6.  ครูสังเกตพฤติกรรมคุณลักษณะที่พึงประสงค์ และบันทึกผล 
 7.  ครตูรวจและบันทึกผลการท างานของนักเรียนลงในแบบเก็บคะแนน 
 8.  ครแูจ้งคะแนนให้นักเรียนทราบ ให้ค าแนะน าเพิ่มเติม และรับฟังข้อเสนอแนะจาก
นักเรียน 
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ฉ เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

ค าชี้แจงส าหรับนักเรียน 

 

เอกสารประกอบการเรียน เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ (E-book) ด้วยโปรแกรม 
Desktop Author เล่มที่ 2 เรื่อง “การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ” เล่มนี้ใช้
ประกอบการจัดกิจกรรมการเรียนการสอนนักเรียนชั้นมัธยมศึกษาปีที่ 1 โรงเรียนท่าตะโกพิทยาคม 
ส านักงานเขตพ้ืนที่การศึกษามัธยมศึกษา เขต 42 มีขั้นตอนในการจัดกิจกรรมการเรียนการสอนดังนี้ 

 1.  นักเรียนฟังค าชี้แจงการใช้เอกสารประกอบการเรียนจากครูให้เข้าใจ 
 2.  นักเรียนรับเอกสารประกอบการเรียน เรียน เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์       
(E-book) ด้วยโปรแกรม Desktop เล่มที่ 2 เรื่อง “การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ”  
เล่มนี้ใช้ประกอบการจัดกิจกรรมการเรียนการสอนนักเรียนชั้นมัธยมศึกษาปีที่ 1 
 3.  นักเรียนท าแบบทดสอบก่อนเรียนเพื่อประเมินความรู้พื้นฐานของตนเอง 
 4.  นักเรียนศึกษาเอกสารประกอบการเรียน เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ (E-book) 
ด้วยโปรแกรม Desktop Author เล่มที่ 2 เรื่อง “การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ”  
ปฏิบัติตามใบความรู้ ใบงาน และแบบฝึกหัด ต้ังแต่หน้าแรกจนถึงหน้าสุดท้าย 
 5.  เมื่อพบค าชี้แจงหรือค าถามในแต่ละเล่มของเอกสารประกอบการเรียน ให้นักเรียนอ่าน
และท ากิจกรรมที่ก าหนดให้ให้ครบถ้วน 
 6.  ส่งผลการท ากิจกรรมการเรียนรู้เพื่อให้ครูตรวจและบันทึกผล 
 7.  เมื่อท าแบบฝึกหัดเสร็จเรียบร้อยแล้ว ให้เก็บอุปกรณ์ให้อยู่ในสภาพเรียบร้อย 
 8.  เมื่อนักเรียนปฏิบัติกิจกรรมการเรียนรู้ครบทกุใบความรู้แล้ว ให้นักเรียนท าแบบทดสอบ
หลังเรียนเพื่อประเมินผลการเรียนรู้ 
 9.  นักเรียนรับฟังผลการท าแบบทดสอบ และข้อเสนอแนะจากครู 
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ในการสร้างหนังสืออิเล็กทรอนิกส์ เราจ าเป็นที่จะต้องก าหนดลักษณะพื้นฐานของหนังสือก่อน 
ไม่ว่าจะเป็นลักษณะรูปเล่ม ขนาด หน้าตาของหนังสือ โดยส่วนที่ส าคัญที่สุดคือปกหนังสือ เพราะจะ
เป็นส่ิงที่ช่วยสื่อถึงรายละเอียดเนื้อหาภายใน  ยิง่เราออกแบบได้สมบูรณ์ สวยงามและส่ือความหมาย
ได้ดีเท่าใด หนังสือเราก็จะเป็นที่น่าสนใจยิ่งขึ้น 

โปรแกรม Desktop Author จะแสดงหน้าหนังสือทั้งทางด้านซ้ายและด้านขวา ดังนั้นในการ
สร้างปก เราจ าเป็นที่จะต้องก าหนดสีขึ้นมาเพื่อปิดหน้าในส่วนที่ไม่ต้องการให้แสดงผล ซึ่งจะท าให้หน้า
นั้นเป็นลักษณะโปร่งใส ซึ่งก็คือการสร้างปกหน้าและปกหลังนั่นเอง 

 

 
 

1. นักเรียนสามารถบอกวิธีการก าหนดรูปแบบหนังสืออิเล็กทรอนิกส์ได้ 
2.  นักเรียนสามารถบอกวิธีแบ่งหน้ากระดาษได้ 
3.  นักเรียนสามารถอธิบายวิธีการบันทึกและการเปิดหนังสืออิเล็กทรอนิกส์ได้ 
4.  นักเรียนสามารถมีทกัษะในการสร้างปกหน้าและปกหลังก าหนดให้มีคุณสมบัติโปร่งใสได้ 
5.  นักเรียนสามารถมีทกัษะในการเพิ่มและลบหน้ากระดาษให้กับหนังสืออิเล็กทรอนิกส์ได้ 
6.  นักเรียนสามารถมีทกัษะในการใส่สีให้กับหน้ากระดาษในหนังสืออิเล็กทรอนิกส์ได้ 
7.  นักเรียนสามารถอธิบายวิธีการสร้างเนื้อหาโดยใช้ Template ได ้
8.  นักเรียนสามารถมีความรอบคอบและเจตคติที่ดีต่อการก าหนดคุณสมบัติเบื้องต้นในการ  
    สร้างหนังสืออิเล็กทรอนิกส์ 

 

 

เอกสารประกอบการเรียน 

จุดประสงค์การเรียนรู้ 

สาระส าคัญ 
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แบบทดสอบก่อนเรียน 

 

 

 
 

1.  ถ้าเราต้องการสร้างไฟล์งานต้องคลิกปุ่มใด 

    ก.          ข.     
 
    ค.           ง.    

2.  ถ้าเราต้องการเพิ่มหน้ากระดาษต้องคลิกปุ่มใด 

    ก.      ข.      
 
    ค.        ง.    

3.  ถ้าเราต้องการลบหน้ากระดาษที่ไม่ต้องการออกต้องคลิกปุ่มใด 

    ก.      ข.      
 
    ค.        ง.    

4.  การก าหนดความกว้างของหนังสือเราก าหนดที่ค าส่ังใด 
    ก. Paper Colour 
    ข. Background Colour 
    ค. Width 
    ง. Height 

5.  Background Colour หมายถึงข้อใด 
    ก. ก าหนดสีหน้ากระดาษ 
    ข. ก าหนดสีพื้นหลัง 
    ค. ก าหนดความกว้าง 
    ง. ก าหนดตัวอักษร 

แบบทดสอบก่อนเรียน 
เรื่อง การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ 

ค าชี้แจง   แบบทดสอบฉบับนี้เป็นแบบปรนัยเลือกตอบ 4 ตัวเลือก จ านวน 10 ข้อ   
    ข้อละ 1 คะแนน  รวม 10 คะแนน 
 ค าส่ัง     ให้นักเรียนเลือกค าตอบที่ถูกต้องที่สุดแล้วท าเครื่องหมาย X ลงในกระดาษค าตอบ 
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6.  ถ้าเราต้องการแบ่งหน้ากระดาษให้ได้ขนาดข้างละ 400 pixels ต้องก าหนดความกว้างเท่าไหร่ 
    ก. 800     ข. 700     
    ค. 600    ง. 500 

7.  เราสามารถเลือกรูปแบบของเส้นแบ่งหน้าที่เมนูค าส่ังใด 
    ก. Buttons > Cartoon Icon 
    ข. Buttons > Close 
    ค. Buttons > Contents 
    ง. Buttons > Dividers 

8.  ถ้าเราต้องการแทรกรูปภาพต้องคลิกปุ่มในข้อใด 

    ก.      ข.      
 
    ค.        ง.    

9.  เราต้องการสร้างปกหนังสือจะต้องสร้างกล่องส าหรับปิดส่วนที่ไม่ต้องการต้องคลิกปุ่มข้อใด 

    ก.      ข.      
 
    ค.        ง.    

10. ถ้าเราต้องการใส่สีหน้ากระดาษเหมือนกันทุกหน้าต้องใช้ค าส่ังในข้อใด 
    ก. Border Colour 
    ข. Mask Colour 
    ค. Paper Colour 
    ง. Background Colour 
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ใบความรูท้ี่ 1 
เรื่อง  การก าหนดรูปแบบของหนงัสืออิเลก็ทรอนิกส ์

 
 

การก าหนดรูปแบบของหนังสืออิเลกทรอนิกส ์

 ให้นักเรียนปฏิบัติการสร้างหนังสือตามขั้นตอนต่อไปนี้ 

 เปิดโปรแกรม Desktop Author เลือก File แล้วคลิกเลือก New 

 

 

 

 

 

 

 

 

 
 

ภาพที่ 2.1 การเปิดโปรแกรมด้วย File แล้วคลิกเลือก New 
 

 หรือคลิกที่ Icon New บนแถบ Toolbar 

  

 

 

 

ภาพที่ 2.2 การเปิดโปรแกรมด้วยการคลิก Icon New 
  

เลือก New 

เลือก New www.kr
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 จากนั้นจะมีหน้าต่าง eBook Properties ขึ้นมาเพ่ือให้เราปรับแต่งหนังสือ ให้นักเรียนปรับ
ค่าตามที่อยู่ในวงกลมสีแดง 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

ภาพที่ 2.3 หน้าต่าง eBook Properties 

ความหมายของ eBook Properties 

ชื่อค าสั่ง ความหมาย 
Width ก าหนดความกว้างของหนังสือ 
Height ก าหนดความสูงของหนังสือ 
Border Colour สีเส้นขอบของหนังสือ 
No Border ไม่มีเส้นขอบหนังสือ 
Paper Colour เลือกสีของหน้ากระดาษ 
Mask Colour เลือกสีที่ใช้ในการท ารูปโปร่งใส 
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ความหมายของ eBook Properties (ต่อ) 

ชื่อค าสั่ง ความหมาย 
Background Colour สีพ้ืนหลัง 
Character Set เลือกภาษาที่ใช้ (ให้เลือกนักเรียนเลือก THAI) 
Text default left ความห่างของกล่องข้อความกับขอบกระดาษซ้ายมือ 
Text default top ความห่างของกล่องข้อความกับขอบกระดาษด้านบน 
Text default width ความสูงของกล่องข้อความ 
Text default height ความกว้างของกล่องข้อความ 
Start with tooltip auto update เปิดหนังสือพร้อมกับเคล็ดลับการใช้เครื่องมือ 
Start with background window เปิดหนังสือพร้อมฉากหลัง 
Disable Send Mail Function ปิดฟังก์ชั่นการส่งเมล์ 
Disable SaveAs Function ปิดฟังก์ชั่นการบันทึกไปยัง 
Disable Search Function ปิดฟังก์ชั่นการค้นหา 
Disable Print Function ปิดฟังก์ชั่นการพิมพ์ 
Disable Print Screen Function ปิดฟังก์ชั่นการกดปุ่ม Print Screen 
Page Turn Speed ก าหนดความเร็วในการพลิกหน้าหนังสือ 
Page Numbering ก าหนดการแสดงหมายเลขหน้า 
Default Unicode Value ก าหนดค่า Unicode เป็นค่าเฉพาะ 
With/Without Password เลือกว่าจะให้หนังสือมีรหัสผ่านหรือไม่ 
eBook Password ใส่รหัสผ่านให้กับหนังสือ 
eBook Backup Files เลือกว่าจะให้มีการสร้างไฟล์ส ารองหนังสือหรือไม่ 
Page Turn ปรับค่าการเปล่ียนหน้าหนังสือ 
Auto Start ให้หนังสือเปลี่ยนหน้าโดยอัตโนมัติ 
Expiry Date ก าหนดวันหมดอายุของหนังสือ 
eBook Transparency ก าหนดค่าต่าง ๆ ในการท าปกหนังสือ 
eBook DRM ก าหนดค่าการป้องกันต่าง ๆ  
eBook AboutBox/Email ก าหนดค าอธิบาย E-mail ผู้จัดท า 
eBook Multimedia เลือก Version ของ Windows Media Player 
Front cover notifier ก าหนดข้อความแจ้งบนปกหนังสือ 
Create author’s index สร้างดัชนีผู้จัดท า 
eBook buttons ก าหนดปุ่มให้กับหนังสือ 
Print ก าหนดขอบเขตการพิมพ์หนังสือ 
eBook Shadow ก าหนดเงา เช่น เงาขอบหนังสือ, เงากึ่งกลางหน้า 
eBook Update สร้าง Link ในการ Update ให้กับหนังสือ 

 

www.kr
oo

ba
nn

ok
.co

m



 

 

7 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

 

 
 

   จงตอบค าถามต่อไปนี้ (10 คะแนน) 
 
1. ให้นักเรียนอธิบายขั้นตอนการสร้างหนังสือ ว่ามีกี่วิธี และท าอย่างไร ( 2 คะแนน ) 
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
 

2. ถ้าต้องการให้หน้าหนังสือมีความกว้าง 800 Pixels ต้องก าหนดที่ใด ( 1 คะแนน ) 
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
 

3. Border Colour หมายถึง ................................................................................ ( 1 คะแนน ) 
 

4. Mask Colour หมายถึง ................................................................................... ( 1 คะแนน ) 
 

5. Character Set หมายถึง ................................................................................. ( 1 คะแนน ) 
 

6. Disable Print Function หมายถึง ................................................................. ( 1 คะแนน ) 
 

7. Page Turn Speed หมายถึง .......................................................................... ( 1 คะแนน ) 
 

8. eBook Backup Files หมายถึง ...................................................................... ( 1 คะแนน ) 
 

9. eBook Transparency หมายถึง .................................................................... ( 1 คะแนน ) 
 

10. eBook buttons หมายถึง ............................................................................ ( 1 คะแนน ) 
 

 
 

 
 

 

 

 

แบบฝึกหัดที่ 1 
 เรื่อง การก าหนดค่าพื้นฐานของหนังสืออิเลกทรอนิกส์ 

ค าชี้แจง 
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ใบความรูท้ี่ 2 
เรื่อง  การแบง่หน้ากระดาษ 

 
การแบ่งหน้ากระดาษ 

 หลังจากที่นักเรียนได้ก าหนด eBook Properties เรียบร้อยแล้ว จะได้หน้ากระดาษดังภาพ 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.4 หน้าต่างแสดงหน้ากระดาษหลังจากที่ได้ก าหนด eBook Properties 

1. ให้เล่ือนเมาส์ไปคลิกยังต าแหน่งไม้บรรทัดเพ่ือท าการแบ่งครึ่งหน้ากระดาษออกเป็นสอง
ส่วนเท่าๆ กัน (ขนาดขึ้นอยู่กับการก าหนดคุณสมบัติในขั้นตอนการเริ่มสร้างหนังสือ) 

 

 

 

 

 

ภาพที่ 2.5 การก าหนดจุดแบ่งครึ่งหน้ากระดาษ 

1. คลิกเมาส์ที่กึ่งกลางหน้ากระดาษเพื่อ
แบ่งกระดาษเป็นสองส่วนเท่าๆ กัน 

2. จะได้เส้นแบ่งต าแหน่ง www.kr
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2. จากนั้นคลิกเมนูค าส่ัง Buttons > Dividers เพ่ือท าการเลือกแบบเส้นในการแบ่งหน้า
หนังสือ  

 

 

 

 

 

 

ภาพที่ 2.6 การเลือกค าสั่งเพ่ือเลือกแบบเส้นการแบ่งหน้าหนังสือ 

3. จะได้หน้าต่าง Buttons Dividers ขึ้นมาให้เลือกรูปแบบของเส้นแบ่งหน้าหนังสือ 
 

 

 

 

 

 
 

ภาพที่ 2.7 แสดงการเลือกรูปแบบของเส้นแบ่งหน้าหนังสือ 

 

 

 

 

1. คลิกเมาส์ที่ Buttons 

2. เลือก Dividers 

1. เล่ือนหาแบบที่ต้องการ 

3. จากนั้นคลิกปุ่ม Use 

2. เลือกชนิดของไฟล์ 
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10 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

4. เมื่อเลือกรูปแบบแล้วจะมีเส้นแบ่งหน้าปรากฏตามรูป สามารถใช้เมาส์คลิกลากไปยัง
ต าแหน่งที่ต้องการได้ 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.8 แสดงการย้ายเส้นแบ่งหน้าต าแหน่งหนังสือ 

 

1. เส้นแบ่งหน้าที่เลือก 

2. ใช้เมาส์คลิกลากมาวางยัง
ต าแหน่งกึ่งกลางหน้ากระดาษ 
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11 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ใบความรูท้ี่ 3 
เรื่อง  การบันทึกงาน 

 
การบันทึกงาน 

 เมื่อท าการสร้างหน้าเอกสารหนังสือขึ้นมาใหม่ ก่อนที่จะด าเนินขั้นต่อไป ให้ท าการบันทึกงาน
เสียก่อน โดยมีขั้นตอนดังนี้ 

 1. ให้นักเรียนสร้าง Folder ใน Drive D: พร้อมตั้งชื่อว่า MyEbook 
 2. คลิกที่ File > Save As… เลือกต าแหน่งที่ต้องการบันทึก ควรสร้างเป็นโฟลเดอร์ จากนั้น
คลิกปุ่ม Save 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.9 แสดงการบันทึกหนังสือที่แทรกเส้นแบ่งหน้าแล้ว 

1. คลิกที่ File 

2. เลือก Save As… 

3. เลือก Folder เพ่ือบันทึก 

5. คลิกที่ Save 

4. ตั้งช่ือไฟล์ www.kr
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12 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ใบงานที่ 1 
เรื่อง  การก าหนดรูปแบบหนังสืออิเล็กทรอนิกส ์

 
จุดประสงค์การเรียนรู้ 

1. นักเรียนบอกวิธีการก าหนดรูปแบบหนังสืออิเล็กทรอนิกส์ได้ 
  2. นักเรียนบอกวิธีแบ่งหน้ากระดาษได ้
  3. นักเรียนสามารถบันทึกไฟล์งานได้ 
 

ค าชี้แจง ให้นักเรียนปฏิบัติตามหัวข้อต่อไปนี้ 
1. ให้นักเรียนเปิดโปรแกรม Desktop Author และสร้างไฟล์งานโดยตั้งค่าหน้ากระดาษกว้าง   

900 pixels สูง 550 
2. ให้นักเรียนแบ่งหน้ากระดาษและเลือกแบบเส้นหน้ากระดาษตามชอบ 
3. ท าการบันทึกไฟล์หนังสือที่สร้างขึ้น โดยใช้ เลขที่ของนักเรียน เป็นช่ือไฟล์ และบันทึกลงใน  

Drive D:  โฟลเดอร์ ชื่อ-นามสกุล ของนักเรียน 
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13 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ใบความรูท้ี่ 4 
เรื่อง  การสร้างปกหน้าหนังสืออิเล็กทรอนิกส์ 

 
การสร้างปกหน้าหนังสืออิเล็กทรอนิกส์ 

 หลังจากที่นักเรียนได้แบ่งครึ่งหน้ากระดาษและใส่เส้นแบ่งหน้าแล้ว ขั้นตอนต่อไปจะสร้างปก
หน้าของหนังสือ โดยปกหน้าหนังสือจะอยู่ด้านขวามือของหน้ากระดาษ โดยมีขั้นตอนสร้างดังนี ้

 1.  เราจะต้องท าการปิดในส่วนหน้าที่ไม่ต้องการให้แสดงผล โดยใช้หลักการก าหนดสีโปร่งใส 
โดยเลือกใช้ค าสั่ง Tools > Book Transparency 

 

 

 

 

 

ภาพที่ 2.10 แสดงการเลือกใช้ค าส่ัง Tools > Book Transparency 

 2.  จะได้หน้าต่างการก าหนดค่า Book Transparency Setting 

 

 

 

 

 

 

 

ภาพที่ 2.11 แสดงการก าหนดค่าในหน้าต่าง Book Transparency Setting 

ใช้เมาส์คลิกที่ Tools เลือก Book Transparency 

1. ใช้เมาส์คลิกคลิก  ใน
ช่อง With Transparency 

2. คลิกปุ่ม Select เพ่ือเลือกสีที่ใช้ส าหรับ
ท าค่าโปร่งใส 

3. เลือกสีแล้วคลิก OK 

4. เมื่อก าหนดค่าเรียบร้อยแล้วคลิก OK 
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14 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

 3.  เมื่อเราก าหนดสีที่ใช้ส าหรับการท าวัตถุให้โปร่งใสแล้ว ขั้นตอนต่อไปเราต้องสร้างวัตถุ
โปร่งใสที่มีสีตามที่เราก าหนดมาปิดหน้าที่ไม่ต้องการให้แสดงผล โดยคลิกเมนู Insert > Box  

 

 

 

 

 

ภาพที่ 2.12 แสดงการสร้างกล่องส าหรับปิดหน้าที่ไม่ต้องการให้แสดงผล 

 4.  เลือกสีของกล่องให้ตรงกับที่ก าหนดไว้ใน Book Transparency Setting 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.13 แสดงการเลือกสีของกล่อง 

 

1. เลือก Insert 

2. เลือก Box 

1. เลือกสีทีต้องการ 

2. กด OK www.kr
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15 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

 5.  จะได้กล่องที่มีสีตามที่เลือกไว้ใน Book Transparency Setting  

 

 

 

 

 

 

 

 

 

ภาพที่ 2.14 แสดงกล่องที่จะใช้ส าหรับปิดหน้ากระดาษด้านซ้าย 

 6.  ใช้เมาส์ลากกล่องที่สร้างขึ้นมาให้พอดีกับหน้ากระดาษที่ต้องการปิดไม่ให้แสดงผล 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.15 แสดงการขยายกล่องเพ่ือปิดส่วนที่ไม่ต้องการให้แสดงผล 

ใช้เมาส์ขยายกล่องเพ่ือ
ปิดหน้ากระดาษด้านซ้าย 

ขยายให้พอดีกับหน้ากระดาษ 
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16 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

7.  เริ่มท าปกด้านขวาซึง่เป็นปกที่ต้องใช้งานจริง ให้แทรกรูปภาพเข้ามาไว้ในกระดาษด้าน
ขวามือ ส่วนที่จะท าเป็นปกหนังสือก่อน โดยคลิกปุ่ม Image ตรงกลุ่มค าสั่ง Insert จะมีหน้าต่างให้
เลือกหารูปภาพที่จะน ามาท าปก 

 

 

 

 

 

 

 

 

ภาพที่ 2.16 แสดงการใช้ค าส่ัง Insert Box 

 8.  จะได้ภาพส าหรับใส่ไว้ในหน้าปกหนังสือ 

 

 

 

 

 

 

 

 

ภาพที่ 2.17 แสดงภาพที่เลือกจากค าส่ัง Insert Image 

1. เลือก Insert Image 

3. เลือก Open 

2. เลือกภาพ 
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17 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

 9.  ใช้เมาส์ลากภาพมาวางยังกระดาษด้านขวา จดัต าแหน่งให้เหมาะสม 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.18 แสดงการจัดต าแหน่งภาพลงในปกหน้าหนังสือ 

 10.  จากนั้นให้นักเรียนบันทึกงานลงในเครื่องคอมพิวเตอร์ ดูผลการสร้างปกหน้า โดยการ 
Package งานที่สร้างขึ้นมา โดยเลือกค าสั่ง DNL Package 
 

 
 
 
 

 
 

ภาพที่ 2.19 แสดงการเลือกค าส่ัง DNL Package 
 

 จะปรากฏหน้าต่างการ Package เกิดขึ้น ดังภาพที่ 2.20 
 
 
 
 

ภาพที่ 2.20 แสดงการประมวลผล Package 
 

 

จัดต าแหน่งรูปภาพให้เหมาะสม 

คลิกที่ DNL Package 

www.kr
oo

ba
nn

ok
.co

m



 

 

18 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

 จะปรากฏหน้าปกหนังสือที่เราสร้างขึ้นมา โดยส่วนด้านซ้ายมือจะไม่แสดงผล เนื่องจากเราปิด
การแสดงผลส่วนนี้ไว้ ด้วยค าส่ัง Book Transparency 

 

 

 

 

 

 

 

 

ภาพที่ 2.21 แสดงหน้าปกหนังสือที่สร้าง 

 หากต้องการจะออกจากหน้าการแสดงผล DNL Package เพ่ือกลับไปยังหน้าต่างการสร้าง
หนังสือให้คลิกเมาส์ปุ่มขวา แล้วเลือกค าสั่ง Exit  

 

 

 

 

 

 

 

 

ภาพที่ 2.22 แสดงขั้นตอนการออกจากหน้าแสดงผล DNL Package   

คลิกเมาส์ปุ่มขวา เลือก Exit www.kr
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19 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ใบงานที่ 2 
เรื่อง  การท าปกหนา้และปกหลังหนังสอือิเล็กทรอนิกส ์(E-Book) 

 
จุดประสงค์การเรียนรู้ 

1. นักเรียนสามารถบอกวิธีการสร้างปกหน้าและปกหลังหนังสืออิเล็กทรอนิกส์ได้ 
2. นักเรียนสามารถก าหนดสีในการสร้างหนังสือได้ 
3. นักเรียนสามารถแทรกรปูภาพลงหน้าปกได้ 

 
ค าชี้แจง ให้นักเรียนปฏิบัติตามหัวข้อต่อไปนี้ 

1. ให้นักเรียนเปิดไฟล์งานที่บันทึกไว้ออกมา 
2. ให้นักเรียนท าปกหน้าและปกหลังหนังสือ อะไรก็ได้ โดยสร้างตามข้อก าหนดดังนี้ 

1.  สีพ้ืนของปกกระดาษตามชอบ 
2.  พิมพ์ข้อความ ที่มี ชื่อหนังสือแล้วตกแต่งข้อความให้สวยงาม 
3. แทรกไฟล์รูปภาพจ านวน 1 รูป ลงหน้ากระดาษปก ให้สวยงาม 
4. ตกแต่งในภาพรวมทั้งหมดให้สวยงามมีลักษณะเด่นเฉพาะ 
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20 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ใบความรูท้ี่ 5 
เรื่อง  การจดัการหนา้หนังสืออิเล็กทรอนกิส์ 

 
การจัดการหน้าหนังสืออิเล็กทรอนิกส์ 

1.  การเพิ่มหน้ากระดาษ (Add Page) 

เมื่อได้ปกหนังสือเรียบร้อยแล้ว ต่อไปให้นักเรียนเพ่ิมหน้ากระดาษให้กบัหนังสืออิเลกทรอ
นิกส์ โดยเลือกเมนู Insert > Page   หรือ เลือก          ในส่วนของ Tools Page  

 

 

 

 

 

 

 

ภาพที่ 2.23 แสดงการเลือกค าส่ังเพ่ิมหน้ากระดาษ 
 

หนังสืออิเลกทรอนิกส์ จะต้องมีส่วนที่เป็นค าน า สารบัญ และเนื้อหา เรียงล าดับต่อเนื่องกัน 
ให้นักเรียนเพิ่มหน้าตามจ านวนเนื้อหาที่ต้องการ โดยเราสามารถสังเกตว่าขณะนี้เราก าลังท างานอยู่ใน
หน้าที่เท่าไร จากทั้งหมดจากทั้งหมดกี่หน้าจากมุมล่างขวามือ  

 

 

 

 

ภาพที่ 2.24 แสดงจ านวนหน้าหนังสือที่ท างานอยู่จากที่มทีั้งหมด 

 

คลิกเมาส์ที่ Add Page 

แสดงหน้าที่อยู่ / จากจ านวนทั้งหมด 
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21 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

2.  การลบหน้ากระดาษ (Delete Page) 

นักเรียนสามารถลบหน้ากระดาษที่เพ่ิมขึ้นมาได้ โดยเปิดหน้าไปยังหน้าทีต่้องการลบ แล้ว
เลือก        ในส่วนของ Tools Page เมื่อกดแล้วจะมีหน้าต่างยืนยันการลบ ถ้านักเรียนต้องการลบ
หน้าออกให้กดปุ่ม OK 

 

 

 

 

 

 

 

 

ภาพที่ 2.25 แสดงการเลือกค าส่ังลบหน้ากระดาษ 
 

3.  การย้ายหน้ากระดาษ (Move Page) 

นักเรียนสามารถย้ายหนา้กระดาษที่แสดงผลไปยังหน้าที่ต้องการได้ โดยเลือก        ในส่วน
ของ Tools Page เมื่อกดแล้วจะมีหน้าต่างย้ายหน้าขึ้นมาให้นักเรียนเลือกต าแหน่งหน้าที่ต้องการแล้ว
กด OK หน้าที่นักเรียนตอ้งการย้ายจะถูกย้ายไปยังหน้าที่เลือก 

 

 

 

 

 

 

 

ภาพที่ 2.26 แสดงการเลือกค าส่ังย้ายหน้ากระดาษ 

1. คลิกเมาส์ที่ Delete Page 

2. เลือก OK 

1. คลิกเมาส์ที่ Move Page 
2. เลือกหน้าที่ต้องการย้ายไป 

3. เลือก OK 
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22 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

4.  การคัดลอกหน้ากระดาษ (Copy Page) 

กรณีที่นักเรียนมีการตกแต่งหน้ากระดาษ และต้องการให้รูปแบบที่ตกแต่งแล้วนั้น น าไปใช้กับ
หน้าอื่น ๆ  ได้ นักเรียนสามารถคัดลอกหน้ากระดาษได้โดยการเลือก        ในส่วนของ Tools Page 
ข้อมูลหน้านั้นจะถูกคัดลอกลงหน่วยความจ า เพื่อรอการวางด้วยค าส่ัง Edit > Paste 

 

 

 

 

 

 

 

ภาพที่ 2.27 แสดงการเลือกค าส่ังคัดลอกหน้ากระดาษ 
 

5.  การเรียกดหูน้ากระดาษ (Previous Page, Next Page, Goto Page) 

นักเรียนสามารถเรียกดหูน้ากระดาษ หรือการพลิกหน้ากระดาษได้จากค าสั่งบน Tools Page 
ซึ่งประกอบไปด้วยค าส่ัง Previous Page, Next Page และ Goto Page 

 

 

 

 

 

 

 

ภาพที่ 2.28 แสดงค าส่ังในการเรียกดูหน้ากระดาษ 

อยู่ในหน้ากระดาษที่ต้องการคัดลอก 
จากนั้นคลิกเมาส์ที่ Copy Page 

Previous Page หรือ
พลิกย้อนกลับ 

Next Page หรือ    
พลิกหน้าต่อไป 

Goto Page หรือไปยังหน้าที่ต้องการ โดยจะมี
หน้าต่างขึ้นมาให้เลือกว่าต้องการพลิกไปหน้าใด 

เลือกหน้าที่ต้องการแล้วกด OK 
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23 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

6.  การเพิ่ม/การลบหน้ากระดาษครั้งละหลายๆ หน้า (Insert / Delete Multiple Pages) 

นักเรียนสามารถเพิ่มหนา้กระดาษหรือลบหน้ากระดาษครั้งละหลาย ๆ หน้าได้โดยการเลือก              
       ในส่วนของ Tools Page 

 

 

 

 

 

 

 

ภาพที่ 2.29 แสดงการเลือกค าส่ังการเพ่ิม/การลบหน้ากระดาษครั้งละหลายๆ หน้า 

 เมื่อนักเรียนคลิกที่ค าสั่ง Insert / Delete Multiple Pages แล้ว จะมีหน้าต่างการเลือกค่า
ในการเพ่ิม หรือลบขึ้นมา โดยมีรายละเอียดดังรูปที่ 2.30 

 

 

 

 

 

 ภาพที่ 2.30 แสดงการเลือกค่าการเพิ่ม/การลบหน้ากระดาษ 

เมื่อนักเรียนเลือกค่าการเพ่ิม/ลบตามที่ต้องการแล้วให้กดปุ่ม OK 

 

 

คลิกที่ปุ่ม Insert / Delete Multiple Pages 

หน้าเริ่มต้นการท างาน 

จ านวนหน้าที่ต้องการ
เพ่ิม/ลบ 

เพ่ิมหน้า ลบหน้า 
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24 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

ใบความรูท้ี่ 6 
เรื่อง  การสร้างปกหลังหนังสืออิเล็กทรอนิกส์ 

 
การสร้างปกหลังหนังสืออิเล็กทรอนิกส์ 

 หลังจากที่นักเรียนได้สร้างปกหน้าของหนังสืออิเลกทรอนิกส์ และท าการแทรกหน้าหนังสือ
แล้ว ต่อมาเราจะต้องท าการสร้างปกหนังให้กับหนังสืออิเลกทรอนิกส์ของเรา โดยมีวิธีสร้างคล้ายกับ
การสร้างปกหน้า โดยมีขั้นตอนสร้างดังนี้ 

 1.  พลิกกระดาษไปหน้าสุดท้าย ด้วยค าส่ัง         หรือ         จากนั้นเราจะต้องท าการปิดใน
ส่วนหน้าที่ไม่ต้องการให้แสดงผลเช่นเดียวกับการท าปกหน้าหนังสือ  โดยใช้หลักการก าหนดสีโปร่งใส 
ให้นักเรียนเลือกค าสั่ง Tools > Book Transparency 
 จะได้หน้าต่างการก าหนดค่า Book Transparency Setting เพ่ือก าหนดสีที่ใช้ในการปิดปก
หลัง ให้นักเรียนก าหนดค่าตามภาพที่ 2.31 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.31 แสดงการก าหนดค่าในหน้าต่าง Book Transparency Setting 

 

 

1. ใช้เมาส์คลิกคลิก  ใน
ช่อง With Transparency 

2. คลิกปุ่ม Select เพ่ือเลือกสีที่ใช้ส าหรับ
ท าค่าโปร่งใส 

3. เลือกสีแล้วคลิก OK 

4. เมื่อก าหนดค่าเรียบร้อยแล้วคลิก OK 
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25 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 

นายสามารถ  กล่อมเกลา  โรงเรียนท่าตะโกพิทยาคม สพม.42 นครสวรรค ์

 2.  เมื่อเราก าหนดสีที่ใช้ส าหรับการท าวัตถุให้โปร่งใสแล้ว ขั้นตอนต่อไปเราต้องสร้างวัตถุ
โปร่งใสที่มีสีตามที่เราก าหนดมาปิดหน้าที่ไม่ต้องการให้แสดงผล โดยคลิกเมนู Insert > Box  

 

 

 

 

 

ภาพที่ 2.32 แสดงการสร้างกล่องส าหรับปิดหน้าที่ไม่ต้องการให้แสดงผล 

 3.  เลือกสีของกล่องให้ตรงกับที่ก าหนดไว้ใน Book Transparency Setting 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.33 แสดงการเลือกสีของกล่อง 

 

1. เลือก Insert 

2. เลือก Box 

1. เลือกสีทีต้องการ 

2. กด OK www.kr
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4.  จะได้กล่องที่มีสีตามที่เลือกไว้ใน Book Transparency Setting ให้นักเรียนลากมาวางไว้
ที่ด้านขวาของหนังสือ 

 

 

 

 

 

 

 

 

ภาพที่ 2.34 แสดงกล่องที่จะใช้ส าหรับปิดหน้ากระดาษด้านขวา 

 5.  ใช้เมาส์ลากกล่องที่สร้างขึ้นมาให้พอดีกับหน้ากระดาษที่ต้องการปิดไม่ให้แสดงผล 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.35 แสดงการขยายกล่องเพ่ือปิดส่วนที่ไม่ต้องการให้แสดงผล 

ใช้เมาส์ลากกล่องมา
หน้ากระดาษด้านขวา 

ขยายให้พอดีกับหน้ากระดาษ 
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 6.  ทดลองแทรกรูปภาพในปกหลัง โดยเลือกค าสั่ง Insert > Image 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.36 แสดงการทดลองแทรกภาพลงในปกหลัง 

7.  จัดต าแหน่งรูปภาพลงในปกหลัง 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.37 แสดงการจัดต าแหน่งภาพในปกหลัง 

1. เลือก Insert Image 

3. เลือก Open 

2. เลือกภาพ 

จัดต าแหน่งรูปภาพตามที่ต้องการ 
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28 เอกสารประกอบการเรียน หนังสืออิเล็กทรอนิกส์ และโปรแกรม Desktop Author 
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ใบความรูท้ี่ 7 
เรื่อง  การสร้างหนังสือด้วย Template 

 
การสร้างหนังสือด้วย Template 

 Template เป็นรูปแบบเอกสารอัตโนมัติที่โปรแกรม Desktop Author เวอร์ชัน 7.1.5 
จัดเตรียมไว้ให้ โดยนักเรียนสามารถเรยีกดูได้จากเมนู Template บนแถบเมนูบาร์ 

 

 

 

 

ภาพที่ 2.38 แสดงการเลือก Template 

จะมี Template ให้เลือกใช้ตามหมวดหมู่ คือ 
  1. Front_Cover คือ Template ที่ใช้ส าหรับท าปกหน้า (ขนาด 960x642) 
 2. Double_Page คือ Template ที่ใช้ส าหรับท าหน้าหนังสือแบบคู่ (ขนาด 960x642) 
 3. Double_Page2 คือ Template ที่ใช้ส าหรับท าหน้าหนังสือแบบคู่ (มีหลายขนาดให้เลือก) 
 4. Back_Cover คือ Template ที่ใช้ส าหรับท าปกหลัง (ขนาด 960x642) 
 5. On_Line คือ การ Download Template จาก Website ผู้ผลิตโปรแกรม 

ตัวอย่าง Template 

 

 

 

 

 

 

ภาพที่ 2.39 ตัวอย่าง Template Front_Cover 

คลิกเมาส์ที่ Template 

ชื่อหมวดหมู่ Template 

ขนาดของ Template 
1. คลิกเมาส์เลือก 
Template ที่ต้องการ 

 

2. เลือก Use เพ่ือเลือกใช้ www.kr
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ภาพที่ 2.40 ตัวอย่าง Template Double_Page 

 

 

 

 

 

 

ภาพที่ 2.41 ตัวอย่าง Template Double_Page2 

 

 

 

 

 

 
 

ภาพที่ 2.42 ตัวอย่าง Template Back_Cover 
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ขั้นตอนการใช้ Template 

 ในการเลือกใช้ Template เพ่ือสร้างหนังสือนั้น จ าเป็นจะต้องเลือกหมวดหมู่ 3 หมวดหมู่ คือ 
หมวดหมู่ของปกหน้า (Front_Cover), เนื้อหา (Double_Page) และปกหลัง (Back_Cover) โดยให้มี
ความกว้างและความสูง ของหนังสือตรงกับขนาดของ Template ที่โปรแกรม Desktop Author 
เตรียมไว้ให้  โดยมีขั้นตอนการสร้างคือ 

 1.  สร้างไฟล์ใหม่ โดยใช้ขนาดความกว้างและความสูง 960x642 Pixels 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.43 แสดงการสร้างหนังสือใหม่ 

 

 

1. คลิกเมาส์ที่ New 

2. ก าหนดค่า Width 960 Pixels 
   ก าหนดค่า Height 642 Pixels 

3. คลิกเมาส์ OK 
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 2.  เลือกแบบปกหน้าโดย คลิกเมนู Template เลือก Template > Front_Cover แล้ว
เลือกรูปแบบของปกที่ต้องการ 

 

 

 

 

 

 

 

 

ภาพที่ 2.44 แสดงการเลือก Front_Cover 

 จะได้หนังสือพร้อมหน้าปกหน้าตาม Template ที่เลือก โดยจะมีการปิดหน้าในส่วนที่ไม่
ต้องการให้แสดงผลด้วยสีโปร่งใสเรียบร้อยแล้ว 

 

 

 

 

 

 

 

 

ภาพที่ 2.45 แสดงหน้าปกที่ได้จาก Template 

1. คลิกเมาส์ Template เลือก Front_Cover 

2. เลือก Template ที่ต้องการแล้วกด Use 
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 3.  ขั้นตอนต่อไปให้ท าการเพิ่มหน้าหนังสือโดยเลือกเมนู Insert > Page หรือ เลือก          
ในส่วนของ Tools Page เมื่อได้หน้ากระดาษเพิ่มขึ้นมาแล้ว ให้นักเรียนเลือก Template ส าหรับ
เนื้อหา โดยคลิกเมนู Template เลือก Template > Double_Page แล้วเลือกรูปแบบของ 
Template ที่ต้องการ 

 

 

 

 

 

 

 

 
 

ภาพที่ 2.46 แสดงการเลือก Double_Page 

 

 

 

 

 

 

 

 

ภาพที่ 2.47 แสดงหน้าเนื้อหาที่ได้จาก Template 

1. คลิกเมาสเ์ลือก Double_Page 

2. เลือก Template ที่ต้องการแล้วกด Use 
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 หากมีเนื้อหาเพิ่มขึ้น นักเรียนสามารถเพิ่มหน้าเนื้อหาได้ โดย Insert > Page แล้วเลือก 
Template ให้กับทุกหน้าที่เพ่ิมขึ้นมาได ้โดยท าตามขั้นตอนที่ 3  

 4.  ขั้นตอนต่อมา เป็นขั้นตอนการสร้างปกหลัง และเลือก Template ให้กับปกหลัง โดย
นักเรียนต้องท าการเพ่ิมหน้าหนังสือขึ้นมาก่อน โดยเลือกเมนู Insert > Page หรือ เลือก          ใน
ส่วนของ Tools Page  
  เมื่อได้หน้ากระดาษเพิ่มขึ้นมาแล้ว ให้นักเรียนเลือก Template ส าหรับปกหลัง โดยคลิกเมนู 
Template เลือก Template > Back_Cover แล้วเลือกรูปแบบของ Template ที่ต้องการ 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.48 แสดงการเลือก Back_Cover 

  

 

 

 

 

1. คลิกเมาสเ์ลือก Back_Cover 

2. เลือก Template ที่ต้องการแล้วกด Use 
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จะได้หนังสือพร้อมหน้าปกหลังตาม Template ที่เลือก โดยจะมีการปิดหน้าในส่วนที่ไม่
ต้องการให้แสดงผลด้วยสีโปร่งใสเรียบร้อยแล้ว 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.49 แสดงปกหลังที่ได้จาก Template 

นักเรียนสามารถปรับแตง่ปกหน้าและปกหลัง โดยการแทรกข้อความหรอืรูปภาพ ได้ตาม
ต้องการ เหมือนการสร้างปกหนังสือโดยไม่ใช้ Template 
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ใบงานที่ 3 
เรื่อง  การจดัการหนา้หนังสือและการใช้ Template สร้างหนังสืออิเล็กทรอนิกส ์

 

จุดประสงค์การเรียนรู้ 

1. นักเรียนสามารถเพิ่มและลบหน้ากระดาษได้ 
2. นักเรียนสามารถแทรกสีและรูปภาพลงหน้ากระดาษได้ 
3. นักเรียนสามารถสร้างเนื้อหาโดยใช้ Template ได ้

 
ค าชี้แจง ให้นักเรียนปฏิบัติตามหัวข้อต่อไปนี้ 

1. ให้นักเรียนเพิ่มหน้ากระดาษจ านวน 3 หน้ากระดาษ 
2. ให้นักเรียนก าหนดสีหน้าของหน้ากระดาษแต่ละหน้าตามใจชอบ 
3. ให้นักเรียนแทรกไฟล์รูปภาพลงหน้ากระดาษแต่ละหน้า ให้สวยงาม 
4. ให้นักเรียนสร้างไฟล์งานและบันทึกช่ือ “ใบงานที่ 3” 
5. ให้นักเรียนสร้างหนังสือโดยใช้ Template ที่โปรแกรมมีไว้ให้ สร้างปกหนังสือ หน้าหนังสือ 

และปกหลังของหนังสือ 
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แบบทดสอบหลังเรียน 
 

 

 

 

1.  ถ้าเราต้องการแบ่งหน้ากระดาษให้ได้ขนาดข้างละ 400 pixels ต้องก าหนดความกว้างเท่าไหร่ 
    ก. 800     ข. 700     
    ค. 600    ง. 500 

2.  เราสามารถเลือกรูปแบบของเส้นแบ่งหน้าที่เมนูค าส่ังใด 
    ก. Buttons > Cartoon Icon 
    ข. Buttons > Close 
    ค. Buttons > Contents 
    ง. Buttons > Dividers 

3.  ถ้าเราต้องการแทรกรูปภาพต้องคลิกปุ่มในข้อใด 

    ก.      ข.      
 
    ค.        ง.    

4.  เราต้องการสร้างปกหนังสือจะต้องสร้างกล่องส าหรับปิดส่วนที่ไม่ต้องการต้องคลิกปุ่มข้อใด 

    ก.      ข.      
 
    ค.        ง.    

5.  ถ้าเราต้องการใส่สีหน้ากระดาษเหมือนกันทุกหน้าต้องใช้ค าส่ังในข้อใด 
    ก. Border Colour 
    ข. Mask Colour 
    ค. Paper Colour 
    ง. Background Colour 

แบบทดสอบหลังเรียน 
เรื่อง การก าหนดค่าพื้นฐานและการสร้างปกหนังสือ 

ค าชี้แจง   แบบทดสอบฉบับนี้เป็นแบบปรนัยเลือกตอบ 4 ตัวเลือก จ านวน 10 ข้อ   
    ข้อละ 1 คะแนน  รวม 10 คะแนน 
 ค าส่ัง     ให้นักเรียนเลือกค าตอบที่ถูกต้องที่สุดแล้วท าเครื่องหมาย X ลงในกระดาษค าตอบ 
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6.  ถ้าเราต้องการสร้างไฟล์งานต้องคลิกปุ่มใด 

    ก.          ข.     
 
    ค.           ง.    

7.  ถ้าเราต้องการเพิ่มหน้ากระดาษต้องคลิกปุ่มใด 

    ก.      ข.      
 
    ค.        ง.    

8.  ถ้าเราต้องการลบหน้ากระดาษที่ไม่ต้องการออกต้องคลิกปุ่มใด 

    ก.      ข.      
 
    ค.        ง.    

9.  การก าหนดความกว้างของหนังสือเราก าหนดที่ค าส่ังใด 
    ก. Paper Colour 
    ข. Background Colour 
    ค. Width 
    ง. Height 

10. Background Colour หมายถึงข้อใด 
    ก. ก าหนดสีหน้ากระดาษ 
    ข. ก าหนดสีพื้นหลัง 
    ค. ก าหนดความกว้าง 
    ง. ก าหนดตัวอักษร 
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ภาคผนวก 
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ชื่อ – สกุล ...................................................................................... ชั้น .......... เลขที่ ......... 
 

แบบทดสอบก่อนเรียน 
 

 แบบทดสอบหลังเรียน 
 

ข้อ ก ข ค ง  ข้อ ก ข ค ง 
1      1     
2      2     
3      3     
4      4     
5      5     
6      6     
7      7     
8      8     
9      9     
10      10     

 

 
สรุปผลการทดสอบ 
 

การประเมิน คะแนนเต็ม ท าได้ ความก้าวหน้า ระดับคุณภาพ 
ก่อนเรียน     
หลังเรียน     
 
 
เกณฑ์การประเมิน 
 

 

 
 
 

คะแนน ระดับคุณภาพ 
9-10 ดีมาก 
7-8 ดี 
5-6 พอใช้ 
0-4 ปรับปรุง 

กระดาษค าตอบ 
เรื่อง การก าหนดค่าพื้นฐาน และการสร้างปกหนังสือ 

 

สรุปผลการเรียนรู ้
      ผ่าน 
      ไม่ผา่น 
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แบบทดสอบก่อนเรียน 
 

 แบบทดสอบหลังเรียน 
 

ข้อ ก ข ค ง  ข้อ ก ข ค ง 
1      1     
2      2     
3      3     
4      4     
5      5     
6      6     
7      7     
8      8     
9      9     
10      10     

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เฉลยค าตอบ 
เรื่อง การก าหนดค่าพื้นฐาน และการสร้างปกหนังสือ 
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แนวการตอบ 
 
1. ให้นักเรียนอธิบายขั้นตอนการสร้างหนังสือ ว่ามีกี่วิธี และท าอย่างไร ( 2 คะแนน ) 
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
 

2. ถ้าต้องการให้หน้าหนังสือมีความกว้าง 800 Pixels ต้องก าหนดที่ใด ( 1 คะแนน )  
………………………………………………………………………………………………………………………………………………. 
………………………………………………………………………………………………………………………………………………. 
 

3. Border Colour หมายถึง ................................................................................ ( 1 คะแนน )  
 

4. Mask Colour หมายถึง ................................................................................... ( 1 คะแนน ) 
 

5. Character Set หมายถึง ................................................................................. ( 1 คะแนน )  
 

6. Disable Print Function หมายถึง ................................................................. ( 1 คะแนน ) 
 

7. Page Turn Speed หมายถึง .......................................................................... ( 1 คะแนน )  
 

8. eBook Backup Files หมายถึง ...................................................................... ( 1 คะแนน ) 
 

9. eBook Transparency หมายถึง .................................................................... ( 1 คะแนน )  
 

10. eBook buttons หมายถึง ............................................................................ ( 1 คะแนน ) 
 

 
 

 
 

 

 

 

มี 2 วิธี คือ 
1. สร้างโดยเลื่อนเมาส์ไปคลิกที่ไอคอน New 
2. สร้างโดยเลื่อนเมาส์ไปคลิกที่เมนู File แล้วเลือก New 

เลื่อนเมาส์ไปคลกิที่ไอคอน Properties แล้วก าหนดค่า Width ให้เท่ากับ 800 Pixels 

ก าหนดสีให้กับเส้นของรูปทรง 

ก าหนดสีให้กับรปูแบบการท าสีโปร่งใส 

การเลอืกภาษาที่ใช้กบัหนังสืออิเลกทรอนิกส์ 

การก าหนดการใช้ฟังก์ชั่นการพิมพ ์

การก าหนดความเร็วในการพลิกหน้าหนังสือ 

การก าหนดการสร้างไฟล์ส ารอง 

การก าหนดคา่ต่าง ๆ ในการสร้างปกหนังสือ 

การก าหนดปุม่ให้กบัหนังสอื 

เฉลยแบบฝึกหัดที่ 1 
 เรื่อง การก าหนดค่าพื้นฐานของหนังสืออิเลกทรอนิกส ์
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หนังสืออ้างองิ 
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 โรงพิมพ/์ชุมนุมสหกรณ์/การเกษตรแห่งประเทศไทย, 2551. 
จิน่า  อุมาล. คู่มือการใช้งานโปรแกรม Desktop Author 5.6.1. [ออนไลน์]. เข้าถึงได้จาก 
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